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Chapter 243

GEE Tests for Two Means
in a Stratified ClusterRandomized Design
Introduction
This procedure calculates power and sample size for tests of two means in a stratified cluster-randomized design
in which the outcome variable is continuous. It uses the work of Wang, Zhang, and Ahn (2017) which give the
power in a size-stratified cluster-randomized design in which the cluster size is allowed to vary within strata. The
analysis is of a simple means model fit with the GEE method.

Technical Details
The following discussion summarizes the results in Wang, Zhang, and Ahn (2017).
Suppose you are interested in comparing the means of two groups (treatment and control). Further suppose that
the response is known to be related to other covariates (such as age, race, or gender) and so their impact needs to
be adjusted for. This may be accomplished by stratifying on the covariates and forming hypotheses about a
common mean difference across all clusters and strata. Often, the stratification is based on cluster size, but this is
not required.
Let 𝑌𝑌𝑘𝑘𝑘𝑘𝑘𝑘 be the continuous outcome of the ith �𝑖𝑖 = 1, … , 𝑛𝑛𝑘𝑘𝑘𝑘 � subject in the jth (𝑗𝑗 = 1, … , 𝐽𝐽𝑘𝑘 ) cluster of the kth
(𝑘𝑘 = 1, … , 𝐾𝐾) stratum. Let 𝑋𝑋𝑘𝑘𝑘𝑘 = 0 or 1 depending on whether the cluster is assigned to the control (0) or
treatment (1) group. Let 𝑅𝑅 = 𝑃𝑃(𝑋𝑋𝑘𝑘𝑘𝑘 = 1) × 100 be the percentage of clusters assigned to the treatment group.
Hence, 𝑅𝑅 = 50 indicates balanced randomization.

Suppose the data will be analyzed using the GEE (generalized estimating equation) method. The mean model is
E�𝑌𝑌𝑘𝑘𝑘𝑘𝑘𝑘 � = 𝛽𝛽0 + 𝛽𝛽1 𝑋𝑋𝑘𝑘𝑘𝑘

where 𝛽𝛽0 = 𝜇𝜇2 is the mean of the control group, 𝜇𝜇1 is the mean of the treatment group, and 𝛽𝛽1 = 𝜇𝜇1 − 𝜇𝜇2 = 𝛿𝛿 is
the treatment effect.
The null hypothesis is 𝐻𝐻0: 𝛽𝛽1 = 0 which is paired with the alternative hypothesis 𝐻𝐻1: 𝛽𝛽1 ≠ 0.

The variance matrix of 𝑌𝑌𝑘𝑘𝑘𝑘𝑘𝑘 has 𝜎𝜎 2 on the diagonal and 𝜌𝜌𝜎𝜎 2 on the off-diagonal for subjects within the same
cluster. Hence 𝜎𝜎 2 is the variance of random error and 𝜌𝜌 is the intracluster correlation coefficient (ICC).

If the GEE estimators of 𝛽𝛽0 and 𝛽𝛽1 , found using an independent working correlation structure, are 𝛽𝛽̂0 and 𝛽𝛽̂1 , then
√𝑁𝑁(𝛽𝛽̂1 − 𝛽𝛽1 ) follows a normal distribution.

243-1
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

GEE Tests for Two Means in a Stratified Cluster-Randomized Design

Let 𝛼𝛼 is the type I error rate, δ is the actual, non-zero, value of the treatment effect, and
𝑣𝑣1 =

𝑣𝑣2 =

1
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,

E�𝑛𝑛𝑘𝑘𝑘𝑘 � = 𝜃𝜃𝑘𝑘 (Average of cluster sizes in stratum k),

Var�𝑛𝑛𝑘𝑘𝑘𝑘 � = 𝜏𝜏𝑘𝑘2 (Variance of cluster sizes in stratum k),
CV�𝑛𝑛𝑘𝑘𝑘𝑘 � =

𝜏𝜏𝑘𝑘
𝜃𝜃𝑘𝑘

= 𝜉𝜉𝑘𝑘 (Variance of cluster sizes in stratum k),

𝑁𝑁 = ∑𝐾𝐾
𝑘𝑘=1 𝐽𝐽𝑘𝑘 𝜃𝜃𝑘𝑘 (Total number of subjects in study),
𝑓𝑓𝑘𝑘 = 100

(𝐽𝐽𝑘𝑘 𝜃𝜃𝑘𝑘 )
𝑁𝑁

(The percentage of the total sample in stratum k).

Three cases of statistical hypotheses are available. If Φ(𝑥𝑥) is the standard normal cumulative distribution
function, the power formula for each case is
1. 𝐻𝐻0: 𝛿𝛿 ≥ 0 versus 𝐻𝐻1: 𝛿𝛿 < 0.
Power = Φ �𝑧𝑧𝛼𝛼 −

𝛿𝛿
�
√𝑣𝑣1 + 𝑣𝑣2

2. 𝐻𝐻0: 𝛿𝛿 ≤ 0 versus 𝐻𝐻1: 𝛿𝛿 > 0.

𝛿𝛿
Power = Φ �
− 𝑧𝑧1−𝛼𝛼 �
√𝑣𝑣1 + 𝑣𝑣2

3. 𝐻𝐻0: 𝛿𝛿 = 0 versus 𝐻𝐻1: 𝛿𝛿 ≠ 0.
Power = Φ �𝑧𝑧𝛼𝛼/2 −

𝛿𝛿
𝛿𝛿
� + Φ�
− 𝑧𝑧1−𝛼𝛼/2 �
√𝑣𝑣1 + 𝑣𝑣2
√𝑣𝑣1 + 𝑣𝑣2

These power formulas are used to conduct a binary search for sample size or odds ratio.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, refer to the Procedure Window chapter.

Design Tab
The Design tab contain most of the parameters and options of interest for this procedure.

Solve For
Solve For
This option specifies the parameter to be solved for using the other parameters. The parameters that may be
selected are 𝛿𝛿, Power, or Sample Size. Select Sample Size when you want to calculate the sample size needed to
achieve a given power and alpha level. Select Power when you want to calculate the power.
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Test
Alternative Hypothesis
Specify the alternative hypothesis, H1.
•

One-Sided (H1: δ < 0)
Refers to a lower-tailed, one-sided test with alternative hypothesis H1: δ < 0.

•

One-Sided (H1: δ > 0)
Refers to an upper-tailed, one-sided test with alternative hypothesis H1: δ > 0.

•

Two-Sided (H1: δ ≠ 0)
Refers to a two-sided test with alternative hypothesis H1: δ ≠ 0.

Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the
hypothesis test. Its accuracy is critical.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal proportions when in fact they are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. For this procedure, a type-I error occurs when you reject the null hypothesis of equal
group proportions when in fact they are equal.
Values must be between zero and one. Historically, an alpha value of 0.05 has been recommended for two-sided
tests and 0.025 for one-sided tests. You should pick a value for alpha that represents the risk of a type-I error you
are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
Enter one or more values of N, the total number of subjects in the study. This parameter is the sum of the subjects
in all clusters or strata. The number of treatment and control subjects depends on the Group Allocation option.
The N subjects are divided among the strata using the 'Percent of N in Each Stratum' setting. These are the 𝑓𝑓𝑘𝑘
values defined above
Example
Suppose that N is 1000 and three strata are used with ‘Percent of N in Each Stratum’ set to 25, 25, 50. The three
stratum sample sizes would be 250, 250, and 500.
The number of clusters is based on this number and the ‘Average of Cluster Sizes’ settings.
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Group Allocation
Select how clusters are allocated to the treatment and control groups.
The choices are
•

Equal (Treatment = Control = 50%)
The clusters are allocated equally to the treatment and control groups. This is accomplished by setting the
percentage allocated to the treatment group (R) to 50.

•

Enter R, the Percentage in Group 1
The clusters are allocated so that R% of them are allocated to the treatment group. The remaining (100-R)%
of the clusters are assigned to the control group.

R (Percentage in Group 1)
Enter one or more values of the percentage of clusters within each stratum that are allocated to group 1
(treatment). All subjects so allocated will receive the treatment. All remaining clusters are allocated to group 2
(control).
Notes
A balanced allocation occurs when this parameter is set to 50.
Since this is a percentage and since at least some clusters must be allocated to each group, this value can range
from 1 to 99.
Realistically, this value will be between 20 and 80.
The smallest total sample size will result from setting this value to 50.

Effect Size
δ (Mean Difference = μ1 - μ2)
Enter a value for the difference between the means of groups 1 and 2 at which the design is powered. That is, the
power is the probability of detecting a difference of at least this amount. This value is not necessarily the true
mean difference. Rather, it is the difference you want to be able to detect.
δ can be any non-zero value (positive or negative). The difference has the same scale as the standard deviation.
You can enter a single value such as 10 or a series of values such as 10 20 30 or 5 to 50 by 5. When a series of
values is entered, PASS will generate a separate calculation result for each value of the series.
σ (Standard Deviation)
Enter the subject-to-subject standard deviation. It may also be thought of as the standard deviation of the random
error term in the GEE model.
σ must be greater than zero.
You can enter a single value such as ‘5’ or a series of values such as ‘1 3 5 7 9’ or ‘1 to 10 by 1’.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
Press the small ‘σ’ button to the right to obtain help in estimating the standard deviation.
ICC (Intracluster Correlation)
Enter a value for ICC, the intracluster correlation coefficient. This may be thought of as the correlation between
any two observations in the same cluster.
Note that occasionally, ICC < 0. Since this is a correlation coefficient, it is possible for it to range from -1 to 1.
You may enter a single value or a list of values, such as 0.01 0.02 0.03.
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Strata Information
Cluster Size Variation Input
There are two ways in which you can specify the variation of the cluster sizes within a stratum. These are
•

Standard Deviation
You will enter the population standard deviation of the cluster sizes within each stratum.

•

Coefficient of Variation
You will enter the population coefficient of variation of the cluster sizes within each stratum.

Set
This is an identification number used on the reports.
Number of Strata
Specify the number of strata specified on this line. Usually, you will enter a ‘1’ to specify a single stratum, or you
will enter a ‘0’ to ignore this line. However, this option lets you specify several strata that have the same
parameter values.
The total number of strata is equal to the sum of these values.
Examples
0 which means ‘ignore this line’.
1 which means ‘one stratum defined by this line’.
2 which means ‘two strata defined by this line’.
Percent of N in Each Stratum
Enter the percentage that the number of subjects in a stratum is of the total number of subjects. If this line defines
more than one stratum, this is the percentage FOR EACH stratum.
These percentages must sum to 100. If they don't, the program will adjust them, so they do.
For example, suppose you enter two sets and specify a Number of Strata for both sets of 5. Further suppose that
you enter 25 for the Percent of N in Each Stratum in both sets. The program would realize that there is a total of
10 strata in the experiment with an equal percentage of the total in each stratum. Thus, the individual percentages
would be adjusted from 25 to 10.
Note that you should only enter one number, even if there are more than one stratum being defined by the line.
Range
These values can be any positive values. The values will be adjusted so that the percentages sum to 100.
Average of Cluster Sizes
Enter the average cluster size of the clusters in a stratum in this set. This number applies to clusters in both the
treatment and the control groups.
The value must be greater than or equal to 1.
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Standard Deviation of Cluster Sizes
Enter the population standard deviation of the cluster sizes in this set. This number applies to both the treatment
and the control groups.
The values must be than or equal to zero.
Example
Suppose the five cluster sizes in a particular stratum are 225, 314, 197, 266, and 248. The average cluster size is
250 and the population standard deviation (using N = 5 in the denominator) is 39.4715.
Coefficient of Variation of Cluster Sizes
Enter the coefficient of variation of the cluster sizes in this set. This number will apply to both the treatment and
the control groups.
Coefficient of Variation (CV)
The coefficient of variation used here is the population standard deviation divided by the mean. It is used to
calculate the standard deviation of the cluster sizes. It is often used because the standard deviation of cluster sizes
is often roughly proportional to the cluster size mean.
The values must be greater than zero.
Show More Strata Sets
Check this box to show ten more Strata Information sets.
If this option is not checked, any active strata sets (Number of Strata > 0) with set identification numbers > 5 will
be ignored.
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Example 1 – Finding Sample Size
A study is being planned to investigate whether a new intervention will decrease a certain response variable. For a
number of reasons, the researchers decide to administer the intervention to whole clusters (clinics) rather than
randomize the treatment to individuals within the cluster. Past experience has shown that clinics can be separated
into small, medium, and large according to their size. They want to obtain an equal number of subjects in each
stratum. The number of clinics receiving each treatment will be balanced.
The average number of subjects per clinic of the small, medium, and large strata are 6, 21, and 73, respectively.
The coefficient of variation of all strata is 0.42.
Prior studies have obtained a mean score of 80 with a standard deviation of 23 and an ICC of 0.03. The
researchers want to compare the necessary sample sizes when the change is -6, -8, and -10. They also want to
consider an ICC value of 0.06.
The two-sided significance level is set to 0.05 and the power is set to 0.8.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load this procedure. You may then make the appropriate entries as listed below, or open Example 1 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ............................................................... Sample Size
Alternative Hypothesis ........................................... Two-Sided (H1: δ ≠ 0)
Power ..................................................................... 0.8
Alpha ...................................................................... 0.05
Group Allocation .................................................... Equal (Treatment = Control = 50%)
δ (Mean Difference = μ1 - μ2) ............................... -6 -8 -10
σ (Standard Deviation) .......................................... 23
ICC (Intracluster Correlation) ................................. 0.03 0.06
Cluster Size Variation Input ................................... Coefficient of Variation
Set 1 Number of Strata .......................................... 1
Set 1 Percent of N in Each Stratum ....................... 33
Set 1 Average of Cluster Sizes .............................. 6
Set 1 Coefficient of Variation of Cluster Sizes ....... 0.42
Set 2 Number of Strata .......................................... 1
Set 2 Percent of N in Each Stratum ....................... 33
Set 2 Average of Cluster Sizes .............................. 21
Set 2 Coefficient of Variation of Cluster Sizes ....... 0.42
Set 3 Number of Strata .......................................... 1
Set 3 Percent of N in Each Stratum ....................... 33
Set 3 Average of Cluster Sizes .............................. 73
Set 3 Coefficient of Variation of Cluster Sizes ....... 0.42
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Set 4 Number of Strata .......................................... 0
Set 5 Number of Strata .......................................... 0
Show More Strata Sets .......................................... Unchecked

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses:
H0: δ = 0 vs. H1: δ ≠ 0
Number of Strata:
3

Power
0.8000
0.8000
0.8000
0.8000
0.8000
0.8000

Total
Sample
Size
N
356
547
557
854
990
1519

Expected
Number of
Clusters
28
41
43
65
76
115

Percent
Allocated to
Treatment
Group
R
50.00
50.00
50.00
50.00
50.00
50.00

Actual
Mean
Difference
δ = μ1 - μ2
-10.00
-10.00
-8.00
-8.00
-6.00
-6.00

Standard
Deviation
σ
23.00
23.00
23.00
23.00
23.00
23.00

Intracluster
Correlation
Coefficient
ICC
0.03
0.06
0.03
0.06
0.03
0.06

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

References
Wang, J., Zhang, S., and Ahn, C. 2017. 'Power analysis for stratified cluster randomisation trials with cluster size
being the stratifying factor.' Statistical Theory and Related Fields, Volume 1, Number 1, pages 121-127.
Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total sample size, i.e., the total number of subjects summed across all strata.
Expected Number of Clusters is an estimate of the total number of clusters of all sizes.
R is the percent of clusters in each stratum that are allocated to the treatment group.
δ = μ1 - μ2 is the mean difference assumed by the alternative hypothesis. This is the difference at which the
power is computed.
σ is the standard deviation of the response. It is the standard deviation of the random error component of the
GEE means model.
ICC is the intracluster correlation coefficient. This is the correlation between any two responses within a particular
cluster.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements ─────────────────────────────────────────────────────────
A stratified cluster-randomized design, which divides the sample among 3 strata, is analyzed using a two-sided
test of the mean difference which is obtained from fitting a means model using GEE. The total sample size of 356
subjects, which is obtained from 28 clusters, achieves 80% power to reject the mean difference of zero assumed
by the null hypothesis when the difference is actually -10.00. The standard deviation of the random error is 23.00.
The intracluster correlation coefficient is 0.03. The significance level of the test is 0.050. Note that each cluster is
completely allocated to either the treatment or control and that 50.00% of the clusters in each stratum are in the
treatment group.
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Strata-Detail Report
Strata-Detail Report ──────────────────────────────────────────────────────────

Set
1
2
3

Number
of Strata
1
1
1

Percent of
N in Each
Stratum
33.33
33.33
33.33

Average
of Cluster
Sizes
6.0
21.0
73.0

Standard
Deviation
of Cluster
Sizes
2.52
8.82
30.66

Coefficient
of Variation
of Cluster
Sizes
0.420
0.420
0.420

Strata-Detail Report Definitions
Set is an identification number on the input screen.
Number of Strata is the number of strata defined by this set (input line).
Percent of N in Each Stratum is the percentage of the total sample size that is allocated to each stratum in this
set.
Average of Cluster Sizes is the average cluster size (number of subjects) in each stratum of this set.
Standard Deviation of Cluster Sizes is the standard deviation of the cluster sizes in each stratum of this set.
Coefficient of Variation of Cluster Sizes is the coefficient of variation (SD/Mean) of the cluster sizes in each
stratum of this set.

This report shows the values of the individual, strata-level parameters that were used.

Plots Section

The values from the Numeric Results report are displayed in this plot.
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Example 2 – Validation using Wang, Zhang, and Ahn (2017)
Wang, Zhang, and Ahn (2017) provide an example of the power analysis of a size-stratified, cluster-randomized
study. We will use their results to validate this procedure.
The number of strata were 200, 510, and 1300. We will enter these values and let the program rescale them into
percentages. The total number of subjects is 2010. The average number of subjects per cluster were 5, 17, and 65.
The corresponding standard deviations were 2.44949, 5.00000, and 22.36068.
The mean difference to be detected is 3. The standard deviation is 12. The value of ICC is 0.05. The significance
level is set to 0.05. They calculate a power of 0.8432.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load this procedure. You may then make the appropriate entries as listed below, or open Example 2 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ............................................................... Power
Alternative Hypothesis ........................................... Two-Sided (H1: δ ≠ 0)
Alpha ...................................................................... 0.05
N (Sample Size)..................................................... 2010
Group Allocation .................................................... Equal (Treatment = Control = 50%)
δ (Mean Difference = μ1 - μ2) ............................... 3
σ (Standard Deviation) .......................................... 12
ICC (Intracluster Correlation) ................................. 0.05
Cluster Size Variation Input ................................... Standard Deviation
Set 1 Number of Strata .......................................... 1
Set 1 Percent of N in Each Stratum ....................... 200
Set 1 Average of Cluster Sizes .............................. 5
Set 1 Standard Deviation of Cluster Sizes ............ 2.44949
Set 2 Number of Strata .......................................... 1
Set 2 Percent of N in Each Stratum ....................... 510
Set 2 Average of Cluster Sizes .............................. 17
Set 2 Standard Deviation of Cluster Sizes ............ 5.00000
Set 3 Number of Strata .......................................... 1
Set 3 Percent of N in Each Stratum ....................... 1300
Set 3 Average of Cluster Sizes .............................. 65
Set 3 Standard Deviation of Cluster Sizes ............ 22.36068
Set 4 Number of Strata .......................................... 0
Set 5 Number of Strata .......................................... 0
Show More Strata Sets .......................................... Unchecked
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results with Continuity Correction
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses:
H0: δ = 0 vs. H1: δ ≠ 0
Number of Strata:
3

Power
0.8432

Total
Sample
Size
N
2010

Expected
Number of
Clusters
90

Percent
Allocated to
Treatment
Group
R
50.00

Actual
Mean
Difference
δ = μ1 - μ2
3.00

Standard
Deviation
σ
12.00

Intracluster
Correlation
Coefficient
ICC
0.05

Alpha
0.050

Strata-Detail Report ──────────────────────────────────────────────────────────

Set
1
2
3

Number
of Strata
1
1
1

Percent of
N in Each
Stratum
9.95
25.37
64.68

Average
of Cluster
Sizes
5.0
17.0
65.0

Standard
Deviation
of Cluster
Sizes
2.45
5.00
22.36

Coefficient
of Variation
of Cluster
Sizes
0.490
0.294
0.344

PASS has also obtained a power of 0.8432 which validates this procedure.
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